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Abstract

The high rate of population growth in Pekanbaru City certainly has high mobility too. Public transportation is
the solution to fulfill mobility in Pekanbaru City. However, there are 57 percent of people who use public
transportation are not satisfied with public transportation services. Along with the times, of course the use of
advances in information technology is very necessary. Therefore, the government requires an android-based
urban transport application as an effort to increase the convenience for all elements of society in accessing
various information related to public transportation directly. This study aims to make the people of Pekanbaru
City who use the NERR application will easily get information on public transport services and make
reservations for urban transport tickets. From this study produced an NERR application that is connected to
the Google Maps API and Realtime Database Firebase that can order BRT tickets online which is processed
by the application to produce tickets in the form of QR Code.
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Abstrak

Tingginya tingkat pertumbuhan penduduk di Kota Pekanbaru tentunya memiliki mobilitas yang tinggi juga.
Angkutan umum menjadi solusi dalam memenuhi mobilitas di Kota Pekanbaru. Akan tetapi, ada 57 persen
masyarakat yang menggunakan angkutan umum merasa tidak puas terhadap layanan angkutan umum. Seiring
perkembangan zaman, tentunya pemanfaatan kemajuan teknologi informasi sangatlah diperlukan. Oleh karena
itu, pemerintah membutuhkan suatu aplikasi angkutan perkotaan berbasis android sebagai upaya untuk
meningkatkan kemudahan bagi seluruh elemen masyarakat dalam mengakses berbagai informasi terkait
angkutan umum secara langsung. Kajian ini bertujuan untuk membuat masyarakat Kota Pekanbaru yang
menggunakan aplikasi NERR akan mudah mendapatkan informasi pelayanan angkutan umum dan melakukan
pemesanan tiket angkutan perkotaan. Dari penelitian ini menghasilkan aplikasi NERR yang terhubung dengan
Google Maps API dan Realtime Database Firebase yang dapat melakukan pemesanan tiket BRT secara online
yang diolah aplikasi menghasilkan tiket dalam bentuk QR Code.

Kata Kunci: Teknologi Informasi, Android, Pemesanan, Tiket, Aplikasi NERR

PENDAHULUAN

Kota Pekanbaru merupakan ibukota dan kota besar di provinsi Riau. Kota ini merupakan
sentra ekonomi terbesar di Pulau Sumatra, dan termasuk sebagai kota dengan tingkat
pertumbuhan, migrasi, dan urbanisasi yang tinggi. Tentunya masyarakat wilayah ibukota
memiliki mobilitas yang tinggi. Hal ini menyebabkan tingginya kebutuhan masyarakat akan
pelayanan transportasi yang handal guna mampu memenuhi kebutuhan masyarakat ibukota
dalam melakukan perpindahan.



Angkutan umum menjadi solusi dalam memenuhi mobilitas di Kota Pekanbaru. Akan tetapi,
ada 57% masyarakat yang menggunakan angkutan umum merasa tidak puas terhadap
layanan angkutan umum terutama kurangnya informasi layanan angkutan umum, dan ada
42% masyarakat juga berpendapat bahwa angkutan umum masih belum adanya kemudahan
informasi terhadap tarif dalam pengaturan sistem angkutan umum yang menyebabkan
penerapan tarif yang dilaksanakan tidak efektif. Seiring perkembangan zaman, tentunya
pemanfaatan kemajuan teknologi informasi sangatlah diperlukan. Sistem informasi
teknologi berbasis aplikasi yang mampu memberikan informasi baik itu bagi pengguna jasa
transportasi karena jumlah penduduk tertinggi kota Pekanbaru menurut kelompok umur
berada rentang umur 15-29 yang merupakan usia produktif akan lebih peka terhadap
perkembangan teknologi. Hal ini diperkuat dengan adanya survei Asosiasi Penyelenggaraan
Jasa Internet Indonesia (APJII) yang menyatakan hampir separuh dari total pengguna
internet di indonesia merupakan masyarakat dalam kelompok umur 19-34 tahun yaitu
sebesar 49,52%.

Oleh karena itu, dalam pengkajian ini dimaksudkan untuk memperkenalkan suatu aplikasi
angkutan perkotaan berbasis android sebagai upaya untuk meningkatkan kemudahan bagi
seluruh elemen masyarakat dalam mengakses berbagai informasi terkait angkutan umum
secara langsung. Hal ini diharapkan dapat menjadi solusi terhadap berbagai permasalahan
yang terjadi selama pengoperasian angkutan perkotaan di Indonesia.

TINJAUAN PUSTAKA

Angkutan Umum

Angkutan umum penumpang adalah angkutan penumpang yang dilakukan dengan sistem
sewa atau bayar dan tujuan diselenggarakannya angkutan umum adalah memberikan
pelayanan angkutan yang baik dan layak bagi masyarakat (Warpani, 1990). Sedangkan
angkutan kota adalah sarana transportasi penumpang perkotaan yang biasanya dijalankan di
jalan raya pada kondisi lalu lintas campuran (mixed trafffic) yang disediakan oleh swasta
atau operator umum dan berada dalam kelompok dan rute tertentu (VMuchic, 1981).
Pengertian umum di sini adalah penumpang atau orang secara umum, tidak membedakan
strata sosial, umur, jenis kelamin, dan lain sebagainya. Siapapun boleh menaiki angkutan
umum asal mampu membayar ongkos sesuai rute yang ditempuh ke tempat yang dituju.

Aplikasi Mobile

Aplikasi mobile berasal dari kata aplikasi dan mobile. Aplikasi yang artinya penerapan,
lamaran, penggunaan (Buyens, 2001). Secara istilah aplikasi adalah program siap pakai yang
direka untuk melaksanakan suatu fungsi bagi pengguna atau aplikasi yang lain dan dapat
digunakan oleh sasaran yang dituju sedangkan mobile dapat diartikan dengan perpindahan
yang mudah dari satu tempat ke tempat yang lain, misalnya telepon mobile berarti bahwa
terminal telepon yang dapat berpindah dengan mudah dari satu tempat ke tempat lain tanpa
terjadi pemutusan atau terputusnya komunikasi.

Maka aplikasi mobile merupakan sebuah program aplikasi yang dapat dijalankan atau
digunakan walaupun pengguna berpindah dengan mudah dari satu tempat ke tempat lain
tanpa terjadi pemutusan atau terputusnya komunikasi. Aplikasi ini dapat diakses melalui



perangkat nirkabel seperti pager, dan telepon selular. Adapun karakteristik perangkat mobile

yaitu:

a. Ukuran yang kecil : Perangkat mobile memiliki ukurang yang kecil. Konsumen
menginginkan perangkat yang terkecil untuk kenyamanan dan mobilitas mereka.

b. Memori yang terbatas : Perangkat mobile juga memiliki memori yang kecil, yaitu
primary (RAM) dan secondary (disk).

c. Daya proses yang terbatas : Sistem mobile tidaklah setangguh rekan mereka yang
desktop.

d. Mengonsumsi daya yang rendah : Perangkat mobile menghabiskan sedikit daya
dibandingkan dengan mesin desktop.

e. Kuat dan dapat diandalkan : Karena perangkat mobile selalu dibawa kemana saja,
mereka harus cukup kuat untuk menghadapi benturan-benturan, gerakan, dan sesekali
tetesan-tetesan air.

f.  Konektivitas yang terbatas : Perangkat mobile memiliki bandwith rendah, beberapa dari
mereka bahkan tidak tersambung.

g. Masa hidup yang pendek : Perangkat-perangkat konsumen ini menyala dalam hitungan
detik kebanyakan dari mereka selalu menyala.

Android

Android adalah perangkat bergerak pada sistem operasi untuk telepon selular yang berbasis
linux (Teguh Arifianto, 2011). Sedangkan android merupakan OS (Operating System)
Mobile yang tumbuh ditengah OS lainnya yang berkembang dewasa ini (Hermawan, 2011).
OS lainnya seperti Windows Mobile, i-Phone OS, Symbian, dan masih banyak lagi. Android
bisa digunakan oleh setiap orang yang ingin menggunakannya pada perangkat mereka.
Android menyediakan platform terbuka bagi para pengembang untuk menciptakan aplikasi
mereka sendiri yang akan digunakan untuk bermacam peranti bergerak. Awalnya, Google
Inc. membeli Andorid Inc., pendatang baru yang membuat peranti lunak untuk ponsel.
Kemudian untuk mengembangkan Android, dibentuklah Open Handset Alliance,
konsorsium dari 34 perusahaan peranti keras, peranti lunak, dan telekomunikasi, termasuk
Google, HTC, Intel, Motorola, Qualcomm, T-Mobile, dan Nvidia. Pada saat perilisan
perdana Android, 5 November 2007, Android bersama Open Handset Alliance menyatakan
mendukung pengembangan standar terbuka pada perangkat selular. Di lain pihak, Google
merilis kode-kode Android di bawah lisensi Apache, sebuah lisensi perangkat lunak standar
terbuka perangkat selular.

Android Studio

Android Studio adalah Integrated Development Enviroment (IDE) untuk sistem operasi
Android, yang dibangun diatas perangkat lunak JetBrains IntelliJ IDEA dan didesain khusus
untuk pengembangan Android (http://developer.android.com/studio/intro, 16 Juli 2019).
IDE ini merupakan pengganti dari Eclipse Android Development Tools (ADT) yang
sebelumnya merupakan IDE utama untuk mengembangkan aplikasi android. Android Studio
menawarkan fitur lebih banyak untuk meningkatkan produktifitas anda saat membuat
aplikasi Android, misalnya:

a. Sistem pembuatan berbasis Gradle yang fleksibel;

b. Emulator yang cepat dan kaya fitur;

c. Lingkungan yang menyatu untuk pengembangan bagi semua perangkat android.



d. Instant Run untuk mendorong perubahan ke aplikasi yang berjalan tanpa membuat APK
baru;

e. Template code dan integrasi GitHUB untuk membuat fitur aplikasi yang sama dengan
mengimpor kode contoh;

f. Alat penguji dan kerangka kerja yang ekstensif;

g. Alat bantu Lint yang dapat memeriksa file sumber proyek dari kemungkinan bug dan
perbaikan optimalisasi untuk keakuratan, keamanan, kinerja, kegunaan, aksesibilitas,
dan internasionalisasi;

h. Dukungan bahasa pemrograman C++ dan Android NDK (Native Development Kit);

i. Dukungan bawaan untuk Google Cloud Platform, mempermudah pengintegrasian
Google Cloud Messaging dan App Engine.

Setiap proyek di Android Studio berisi satu atau beberapa modul dengan source code files

dan resource files. Jenis-jenis modul mencakup:

a.  Modul Aplikasi Android

b. Modul Perpustakaan

c. Modul Google App Engine

Pada dasarnya Android Studio menampilkan file proyek dalam tampilan proyek android.

Tampilan ini diatur menurut modul untuk memberi akses cepat ke file suber kunci proyek.

Semua versi file terlihat di bagian atas dibawah Gradle Script dan masing-masing modul

aplikasi berisi folder berikut:

a. Manifest, berisi file AndroidManifest.xml

b. Java, berisi file kode sumber Java, termasuk kode pengujian JUnit.

C. Res, berisi semua sumber daya bukan kode seperti tata letak, String Ul, dan gambar
bitmap.

METODOLOGI PENELITIAN

Dalam penelitian ini, hipotesis yang dapat dirumuskan adalah “Masyarakat Kota Pekanbaru
yang menggunakan aplikasi Nerr akan mudah mendapatkan informasi pelayanan angkutan
umum dan melakukan pemesanan tiket angkutan perkotaan”.

Tahapan Penelitian

1. Identifikasi Masalah
Langkah pertama yang dilakukan yaitu melakukan identifikasi terhadap permasalahan
agar diketahui masalah apa saja yang terjadi di wilayah studi yaitu Kota Pekanbaru.

2. Pengumpulan Data
Langkah kedua yaitu melakukan pengumpulan data. Data yang dikumpulkan yaitu
berupa data primer dan data sekunder. Data primer merupakan data yang diperoleh dari
pelaksanaan survei secara langsung dilapangan. Sedangkan, data sekunder merupakan
data yang diperoleh dari instansi pemerintah atau non pemerintah tanpa adanya survei
secara langsung.

3. Pengolahan Data
Langkah ketiga yaitu melakukan pengolahan data. Data primer dan data sekunder yang
telah didapatkan sebelumnya, selanjutnya diolah agar sesuai dengan kebutuhan
penelitian.



4. Pembuatan Aplikasi
Langkah selanjutnya yaitu melakukan pembuatan aplikasi. Aplikasi dibuat
menggunakan software Android Studio versi 3.1.0.0. Aplikasi yang dibuat diberi Nama
Nerr.

5. Pengujian Aplikasi
Setelah aplikasi selesai, selanjutnya dilakukan pengujian. Pengujian dapat dilakukan
dengan melakukan tes secara langsung.

6. Penggunaan Aplikasi
Langkah selanjutnya yaitu penggunaan aplikasi Nerr.

Metode Pengumpulan Data
Metode pengumpulan data untuk menulis Skripsi ini meliputi pengumpulan berbagai
informasi yang berkaitan dengan data-data yang diperlukan yaitu:
1. Data Primer
Data primer merupakan data yang didapatkan dengan melakukan survei dan data
tersebut mengacu pada keadaan yang sebenarnya. Survei yang dilakukan yaitu dengan
melakukan pengamatan langsung terkait rute yang dilalui oleh suatu trayek. Nantinya
dapat diketahui apakah rute yang dilalui trayek tersebut sudah sesuai dengan izin yang
diberikan oleh Pemerintah. Selain itu data yang dibutuhkan yaitu data titik henti
didasarkan atas lokasi halte. Data primer yang dibutuhkan antara lain:
a. Data koordinat prasarana yaitu terminal dan halte
Data yang dibutuhkan yaitu berupa data koordinat titik terminal dan halte yang
dapat diketahui dari Google Maps.
b. Data koordinat rute koridor BRT
Data yang dibutuhkan yaitu berupa data koordinat rute yang terbentuk dari
beberapa titik halte atau tempat pemberhentian yang dilewati koridor 1 BRT yang
dapat diketahui dari Google Maps.
c. Data karakteristik pelayanan koridor BRT yaitu waktu perjalanan
Data yang dibutuhkan yaitu waktu perjalanan koridor 1 BRT yang didapatkan dari
hasil laporan umum Kota Pekanbaru.

2. Data Sekunder
Data sekunder merupakan data yang didapatkan dari instansi terkait yang berhubungan
dengan studi lalu lintas. Data sekunder yang dibutuhkan antara lain:
a. Peta jaringan jalan dari Dinas Pehubungan Kota Pekanbaru
b. Petajaringan trayek untuk koridor BRT dari Dinas Perhubungan Kota Pekanbaru.

Tahapan Pembuatan Aplikasi

Pada bagian ini menjelaskan tentang tahapan dalam pembuatan aplikasi pelayanan

informasi dan pemesanan angkutan umum berbasis sistem operasi Android yaitu:

1. Membuat proyek pada aplikasi Android Studio.
Langkah awal yaitu membuat proyek aplikasi android yang akan dibuat menggunakan
aplikasi Android Studio yang sudah dipasang pada perangkat komputer atau laptop.

2. Menghubungkan proyek dengan Google Maps API.
Langkah kedua yaitu proyek yang telah dibuat lalu dihubungkan dengan Google Maps
API. Google Maps menawarkan API (Application Programming Interface) yang
memungkinkan aplikasi Android untuk dimasukkan peta di dalamnya.



3. Menghubungkan proyek dengan Firebase.
Langkah terakhir yaitu menghubungkan proyek dengan Firebase yang memiliki fungsi
adalah realtime database yang akan dimuat pada aplikasi ini.

ANALISA DAN PEMECAHAN MASALAH

Proses Pembuatan Aplikasi

Aplikasi NERR merupakan aplikasi yang memanfaatkan sistem operasi Android dimana
dalam pembuatannya menggunakan beberapa perangkat lunak lainnya. Secara garis besar,
aplikasi yang digunakan diantaranya yaitu:

1. Android Studio;

2. Firebase;

3. Google Maps API;

Dipilihnya Android Studio adalah karena Android Studio merupakan satu-satunya aplikasi
pengembangan software Android yang didukung oleh Google. Android merupakan salah
satu produk perusahaan Google itu sendiri. Selanjutnya, dipilih Firebase sebagai pengampu
penyedia layanan database adalah karena database di Firebase bersifat gratis, online, dan
memiliki komunitas yang luas, stabil, serta responsif.

1. Membuat Proyek

Untuk membuat aplikasi NERR, hal pertama yang harus dilakukan yaitu membuat sebuah
project baru pada Android Studio. Pada saat pertama kali membuka aplikasi Android Studio,
aplikasi akan menampilkan layar Selamat Datang. Untuk membuat proyek baru, klik “Start
New Android Studio project”. Jika sebelumnya pengguna sudah memiliki proyek, Android
Studio akan menunjukkan lingkungan pembuatan aplikasi. Untuk membuat proyek baru,
pilih File > New > New Project.

2. Menghubungkan Proyek dengan Google Maps API

Langkah selanjutnya yaitu menghubungkan proyek dengan Google Maps API. Google Maps
menawarkan API yang memungkinkan peta untuk dimasukkan pada aplikasi Android,
danmenawarkan petunjuk lokasi untuk bisnis perkotaan dan organisasi lainnya di berbagai
negara di seluruh dunia.

Aplikasi NERR merupakan aplikasi yang menggunakan bantuan Google Maps API dalam
pengoperasiannya. Hal ini memungkinkan aplikasi NERR agar dapat menampilkan peta
milik Google pada aplikasi NERR yang nantinya dapat digunakan aplikasi untuk
menunjukkan lokasi dari masing-masing pengguna aplikasi.

Untuk menghubungkan proyek dengan Google Maps API, pilih File > New > Google >
Google Maps Activity.

3. Pembuatan Database Online dengan Firebase

Dalam penggunaannya, Aplikasi NERR membutuhkan sinkronisasi data antar pengguna
aplikasi. Data tersebut dapat berupa profil penumpang, profil pengemudi, dan lain
sebagainya. Untuk melakukan serah terima data antar ponsel, aplikasi membutuhkan suatu
layanan yang dapat melakukan sinkronisasi data antar ponsel. Sehingga data yang terdapat
pada aplikasi di masing-masing ponsel pengguna dapat saling terhubung. Untuk dapat
melakukan hal tersebut, Google menyediakan layanan Firebase.

Untuk dapat menghubungkan proyek Android Studio dengan Firebase, pengguna dapat
menggunakan fitur Firebase Assistant bawaan Android Studio dengan cara memilih Tools >
Firebase. Maka akan muncul jendela Firebase Assistant yang terdapat pada sisi kanan
Android Studio.



Pada jendela Firebase Assistant pengguna akan dihadapkan pada berbagai fitur-fitur yang
dimiliki oleh Firebase. Dalam pembuatan aplikasi NERR, fitur yang akan digunakan
diantaranya yaitu Firebase Authentication, Firebase Realtime Database, serta Firebase
Storage.

Firebase Auth merupakan layanan sistem otentikasi yang menerapkan client-side code,
sehingga user dapat mendaftar/ masuk ke aplikasi. Firebase Auth mendukung email &
password, Facebook, Twitter, GitHub, dan Google Sign-In.

4. Melakukan Pengujian Aplikasi

Untuk melakukan pengujian terhadap aplikasi, pengguna dapat melakukannya dengan 2 cara
diantaranya yaitu dengan menjalankannya di perangkat Android sungguhan atau
menggunakan emulator android.

Dalam melakukan pengujian, akan lebih baik jika menggunak perangkat Android. Hal ini
memungkinkan pengguna untuk mengetahui secara langsung kinerja aplikasi yang telah
dibuat apakah dapat berjalan lancar di perangkat Android sungguhan. Untuk menjalankan
aplikasii pada perangkat Android sungguhan, pengguna harus menyiapkan terlebih dahulu
perangkat Android dengan menggunakan kabel USB.

Setelah perangkat terhubung, aktifkan mode USB debugging pada Developer Options di
perangkat Android. Masing-masing perangkat biasanya memiliki cara yang berbeda untuk
mengaktifkan mode USB debugging.

Setelah perangkat berhasil diaktifkan kedalam mode USB debugging, selanjutnya pada
aplikasi Android Studio, klik modul app di jendela Project dan pilih Run > Run (atau klik
Run di toolbar). Kemudian akan muncul jendela Select Deployment Target, pilih perangkat
anda, dan klik OK.

Cara Menggunakan Aplikasi
Aplikasi NERR dibuat dengan tampilan dengan user friendly, artinya aplikasi NERR dapat
diakses dengan mudah oleh siapapun baik itu yang sudah lama menggunakan smartphone
android, maupun yang baru pertama kali sekalipun sehingga dapat memudahkan para
penggunanya untuk mendapat informasi terkait angkutan perkotaan dengan cepat dan akurat.
Pada bagian ini, akan dibahas mengenai tahapan penggunaan aplikasi NERR.
Untuk menggunakan aplikasi NERR, pengguna harus terlebih dahulu memasang aplikasi
NERR pada ponsel Android pengguna. Berikut ini adalah panduan pemasangan aplikasi
NERR pada ponsel Android.
1. Cara Mendapatkan Aplikasi NERR
Untuk mendapatkan aplikasi NERR, saat ini aplikasi baru bisa didapatkan dengan
mengunduhnya di website dan dikirimkan melalui melalui e-mail, bluetooth, dan alat serah
terima data lainnya.
2. Proses Instalasi
Setelah mendapatkan paket file NERR, tahap selanjutnya yaitu tahap instalasi. Untuk dapat
melakukan instalasi, ponsel harus memiliki spesifikasi minimal Android versi Lollipop
(android 5.0).
Setelah proses instalasi dikerjakan, maka aplikasi NERR dapat diakses di ponsel Android
yang sudah diinstal. Selanjutnya akan dibahas mengenai cara menggunakan aplikasi NERR.
3. Penggunaan Aplikasi
Untuk menjalakan aplikasi NERR ada beberapa hal yang perlu diperhatikan diantaranya:

a. Atur ponsel agar tersambung dengan jaringan internet. Pastikan sambungan internet

ponsel dalam kondisi baik;



b. Aktifkan mode GPS (Global Positioning Systems) pada ponsel untuk meningkatkan
akurasi dalam penentuan posisi ponsel pada peta.
c. Pilih aplikasi NERR untuk menjalankan Aplikasi NERR

Kelebihan dan Kekurangan Aplikasi

Aplikasi NERR merupakan aplikasi yang masih berupa prototype, artinya dalam

penggunaannya masih perlu pengolahan serta analisa lebih lanjut agar layak digunakan oleh

seluruh lapisan masyarakat. Beberapa kelebihan aplikasi ini diantaranya:

1. Aplikasi ini menggunakan teknologi android, sehingga sesuai dengan perkembangan
teknologi yang ada saat ini;

2. Dapat diakses dimanapun, aplikasi NERR dapat diakses dimana saja dan kapan saja
selama ada koneksi internet;

3. Informatif, aplikasi NERR lebih informatif dibandingkan dengan informasi yang ada
pada halte yang masih bersifat konvensional;

4. Data yang ditampilkan pada aplikasi bersifat realtime, artinya sesuai dengan kondisi
sebenernya dilapangan;

5. Konsep yang dimiliki pada aplikasi ini memiliki potensi yang besar untuk terus
dikembangkan agar sesuai dengan kebutuhan pelayanan transportasi. Sehingga dapat
dijadikan sebagai sarana yang paling informatif terkait dengan pelayanan angkutan
perkotaan.

Beberapa kekurangan yang masih terdapat dalam aplikasi ini diantaranya:

1. Aplikasi masih dalam tahap uji coba, artinya masih perlu dilakukannya berbagai riset
agar sesuai dengan kebutuhan masyarakat dan pemerintah yang menaunginya;

2. Untuk dapat mengakses aplikasi dibutuhkan koneksi internet;

3. Hanya dapat digunakan pada perangkat yang menggunakan sistem operasi Android.
Perangkat yang menggunakan sistem operasi selain Android seperti 10S dari Apple
masih belum bisa menggunakan aplikasi ini;

4. Masih ditemukan beberapa bugs dan error pada saat menjalankan aplikasi.
Untuk dapat memaksimalkan fungsi dari aplikasi NERR tentu merupakan hal yang tidak
mudah. Perlu adanya komitmen yang kuat dari seluruh pihak yang terlibat baik itu dari sisi
masyarakat umum dan pemerintah. Dengan adanya aplikasi ini diharapkan mampu untuk
meningkatkan kemudahan bagi masyarakat untuk mendapatkan informasi terkait angkutan
perkotaan, membantu pengoperasian kendaraan bagi pengemudi, serta membantu
pemerintah maupun perusahaan angkutan perkotaan untuk melakukan pengawasan terkait
pengoperasian angkutan perkotaan.

KESIMPULAN DAN SARAN

Kesimpulan

1. Kurangnya fasilitas informasi angkutan perkotaan di Kota Pekanbaru. Berdasarkan hasil
survei inventarisasi halte di Kota Pekanbaru. Berdasarkan hasil survei inventarisasi halte
di Kota Pekanbaru, terdapat 165 halte dari 13 koridor yang dilalui.

2. Koridor 1 merupakan koridor dengan rute Perum Pandau — Ramayana. Koridor ini
merupakan koridor melalui berbagai pusat kegiatan diantaranya kawasan pemukiman
(Perum Pandau), sekolah, rumah sakit, kawasan perkantoran (Ratu Kaca Mayang,
Sudirman Square), serta kawasan perbelanjaan (Mal Pekanbaru, Ramayana).



NERR merupakan suatu aplikasi angkutan perkotaan berbasis Android yang

memanfaatkan teknologi GPS (Global Positioning System). GPS berfungsi sebagai alat

untuk melacak posisi pengguna yang terpasang pada masing-masing ponsel pengguna.

Untuk dapat menggambarkan jalur lintasan trayek pada aplikasi NERR, hal yang perlu

dilakukan yaitu menentukan koordinat titik pada peta agar sesuai dengan lokasi

sebenarnya.

Titik henti merupakan titik yang dijadikan sebagai tempat naik turun penumpang

angkutan perkotaan. Lokasi titik henti ditentukan berdasarkan lokasi halte yang terdaftar

di Dishub Kota Pekanbaru.

Aplikasi NERR bisa didapatkan dengan mengunduhnya di website atau dikirmkan

melalui e-mail atau bluetooth.

Untuk menjalankan aplikasi NERR, ada beberapa hal yang perlu diperhatikan

diantaranya:

a. Atur ponsel agar terhubung denga jejaring internet. Pastikan sambungan internet
ponsel dalam kondisi baik;

b. Aktifkan mode GPS (Global Positioning System) pada ponsel untuk meningkatkan
akurasi dalam penentuan posisi ponsel pada peta.

c. Pilih logo aplikasi NERR untuk menjalankan Aplikasi NERR.

Saran

1.

2.

Diperlukan penyajian sisitem informasi angkutan umum yang sesuai perkembangan
teknologi saat ini.

Aplikasi NERR masih menggunakan API dari Google versi gratis, yang mana masih
terdapat batasan dalam penggunaannya. Oleh karena itu, perlunya peningkatan versi
Google API guna meningkatkan kemampuan aplikasi.

Perlunya studi lebih lanjut terkait perkembangan aplikasi agar sesuai dengan kebutuhan
masyarakat dan berbagai pihak lainnya.

Diperlukan komitmen dari pemerintah untuk terus mengkatkan pelayanan angkutan
umum dengan meningkatkan pemanfaatan terhadap perkembangan teknologi informasi
yang ada saat ini.
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